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For Your Reference… 
To export records to Microsoft Excel: 

1. Open the table to export 
2. On the External Data tab, click on Excel in 

the Export group 
3. Complete the steps in the wizard 

Handy to Know… 
• The Save Export Steps options of the 

Export Wizard allows you to save any 
export settings you may have used. This is 
handy if you need to perform the same 
operation on a routine basis. If you only do 
the export as a one-off operation, there is 
probably no need to retain the steps. 

XPORTING RECORDS TO MICROSOFT EXCEL 
 

Microsoft Excel comes from the same suite of 
products as Microsoft Access, so exporting 
records is easy and relatively effortless. The 
built-in Export Wizard automatically converts 

fields from an Access database into columns and 
converts Access records into rows. This enables 
easy export of the data to an Excel workbook. 

 
 

 

Try This Yourself: 
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Before starting this 
exercise you MUST open 
the file Exporting 
Records_1.accdb… 

1 In the Navigation pane, 
double-click on the table 
Employees – 
Administration to open it 

2 Click on the External 
Data tab, then click on 
Excel in the Export group 
to display the Export 
Wizard 

Here you can specify a 
destination File name and 
location… 

3 Click on [Browse], then 
locate and double-click on 
the course files folder 

We will apply the file 
name that appears by 
default… 

4 Click on [Save], then click 
on [OK] to perform the 
export and display the 
Save Export Steps 
option in the wizard 

5 Ensure that Save export 
steps appears without a 
tick, then click on [Close] 
to return to the table 

6 Close the table 
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For Your Reference… 
To export records to a text file format: 

1. Open the table to export 
2. On the External Data tab, click on Text File 

in the Export group 
3. Complete the steps in the wizard 

Handy to Know… 
• There are two types of text files. One type 

has the data delimited (enclosed) with 
quotation marks and separated by commas. 
The other type is where the data is fixed 
length. The delimited type, while it sounds 
more complex, is the one most supported by 
other applications. 

EXPORTING RECORDS TO A TEXT FILE 
 

Text files are the mainstay of data exporting and 
importing. Virtually every application that has 
data will have a way of importing and exporting 
text file formats. So, if you intend to export 

Access records to an application that doesn’t 
appear in the export options, you can simply export 
it as text and then import it into the destination 
application. 

 
 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Exporting 
Records_1.accdb... 

1 Open the Employees – Sales 
table 

2 Click on the External Data 
tab, then click on Text File in 
the Export group to display 
the Export Wizard 

Exporting to text requires a few 
extra steps... 

3 Click on [Browse], locate and 
select the course files folder, 
then click on [Save] to set the 
destination and click on [OK] 

4 Ensure that Delimited is 
selected, then click on [Next] 
to specify the delimiter 
character 

5 Ensure that Comma is 
selected as the delimiter, then 
click on [Next] 
We’ll use the suggested 
filename… 

6 Click on [Finish] to display the 
Save Export Steps option in 
the wizard 

7 Ensure that Save export 
steps appears without a tick, 
then click on [Close] 

8 Close the table 
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For Your Reference… 
To import data from Microsoft Excel: 

1. On the External Data tab, click on Excel in 
the Import & Link group 

2. Choose the file to import, then click on [OK] 
3. Complete the steps of the Get External Data 

wizard 

Handy to Know… 
• When importing data from Excel, Access has 

to manipulate the data from a 3-dimensional 
spreadsheet format into a 2-dimensional 
database format – that is why there are quite 
a few steps in the import wizard. 

IMPORTING FROM MICROSOFT EXCEL 
 

Importing data from Microsoft Excel is a 
straightforward process, but there are several 
more steps than you might expect. This is 
because Access has to take into account so 

many of the different nuances in Excel data. The 
Import Wizard guides you through the steps, 
prompting for responses about the Excel data 
being imported. 

 
 

 

Try This Yourself: 

O
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 Before starting this exercise 

you MUST open the file 
Importing Records_2.accdb… 

1 Click on the External Data tab, 
then click on Excel in the 
Import & Link group to start 
the Get External Data wizard 

2 Click on [Browse] to display 
the File Open dialog box, then 
locate and open the course files 
folder 

3 Click on Employees – 
Import.xlsx, then click on 
[Open] 

4 Click on Append a copy of the 
records to the table and 
ensure that Employees is the 
selected table 

5 Click on [OK] to display the 
Import Spreadsheet Wizard 
screen 

6 Click on [Next] to display the 
column headings 

7 Click on [Next] to display the 
final screen 

8 Click on [Finish] to display the 
Save Import Steps screen, 
ensure that Save import steps 
appears without a tick, then 
click on [Close] 

9 Open the Employees table to 
view the imported data, then 
close the table 
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For Your Reference… 
To import data from a text file: 

1. On the External Data tab, click on Text File 
in the Import & Link group 

2. Choose the file to import and click on [OK] 
3. Complete the steps of the Get External Data 

Wizard 

Handy to Know… 
• When importing data, you should always 

open the table into which the data was 
imported to ensure that it has been imported 
correctly. 

IMPORTING FROM A TEXT FILE 
 

Since text file formats are common in the 
computer world it is only logical to expect that 
Access would have routines that allow you to 
import from text files. When importing data from a 

text file, Access needs to have specific information 
about the format of the data and it will prompt you 
for this information through a series of steps in the 
Get External Data Wizard. 

 
 

 

Try This Yourself: 

Sa
m

e 
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 Continue using the previous file 

with this exercise, or open the 
file Importing Records_3.accdb... 

1 Click on the External Data tab, 
then click on Text File in the 
Import & Link group to start the 
Get External Data wizard 

2 Click on [Browse] to display the 
File Open dialog box, ensure the 
course files folder is open, then 
click on Employees – Import.txt 
and click on [Open] 

3 Click on Append a copy of the 
records to the table and ensure 
the Employees table is selected 

4 Click on [OK] to display the 
Import Text Wizard screen 

5 Ensure that Delimited is 
selected, then click on [Next] to 
display the delimiters options 

6 Ensure that Comma is selected, 
then click on [Next] to see the 
final screen 

7 Click on [Finish] to display the 
Save import steps screen, 
ensure that Save import steps 
appears without a tick, then click 
on [Close] 

8 Open the table Employees to 
see the additional imported 
records, then close the table 
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For Your Reference… 
To create a link to an external source: 

• Perform the import in the normal way except 
choose the Link to the data source by 
creating a linked table option on the first 
screen 

Handy to Know… 
• There are pros and cons associated with 

linking to an external data source. Although 
you always get the latest data, you are 
restricted in what can be done with it. If you 
need to import data on a regular basis, use 
this option, otherwise stick with the straight 
import routines. 

LINKING TO AN EXTERNAL SOURCE 
 

In Access you can elect to link to an external 
data source. When you do this, the external 
source appears like a table in the Navigation 
pane. The linked table can be opened and 

viewed like any other table, but the data cannot be 
changed. The advantage of this approach is that 
the linked table always contains the most recent 
changes to the external data source. 

 
 

 

Try This Yourself: 

Sa
m
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Continue using the previous 
file with this exercise, or open 
the file Importing 
Records_4.accdb... 

1 Click on the External Data 
tab, then click on Excel in the 
Import & Link group, to start 
the Get External Data wizard 

2 Click on [Browse] to display 
the File Open dialog box, 
ensure the course files folder 
is open, then click on 
Employees – Import.xlsx and 
click on [Open] 

3 Click on Link to the data 
source by creating a linked 
table, then click on [OK] to 
display the Link Spreadsheet 
Wizard screen 

4 Click on [Next] to display the 
column headings screen 

5 Ensure that First Row 
Contains Column Headings 
is selected, then click on 
[Next] to display the final 
screen 

6 Click on [Finish] 
A message will display when 
linking is complete… 

7 Click on [OK] to see the linked 
table in the Navigation pane 
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UNDERSTANDING FORMS 
 

Forms are like special templates that you can 
use to make data, which would normally appear 
in rows and columns in a table, more presentable 
on screen. Forms can be used for viewing data 

on the screen, for editing data, and for adding new 
data. Forms can be created quickly from scratch, 
based on an existing table, or by using a special 
Wizard that steps you through the process. 

 
 

 

Creating Forms 
Working with records in tables is not difficult to do. However, opening a table and allowing people to 
work directly in it can be fraught with problems. They may inadvertently delete records, or corrupt data 
in fields, and even see some fields of data (such as salary information) that you would prefer they 
rather did not. 
So, instead of providing users with direct access to the data in a table, you can control what they see 
and what they work with, by giving them access to the data through forms. 
Forms themselves do not contain data, but are created as structural templates into which the data is 
placed when the form is viewed. The template basically defines what to display (e.g. which fields to 
use), where to display it (e.g. where the fields should appear on the page), and how it should look (e.g. 
font size, colour, etc). 
When a form is first created it is based on either an existing table or an existing query. You base the 
form on a table if you wish to report on all of the data, or a query if you wish to view a subset of the 
data. 

 
The Many Ways of Creating a Form 

In Access you can create simple forms or very complex and intricate forms. So, as you’d expect, 
Access offers several ways for you to create forms. In Access, forms are created using the tools on the 
Create tab of the ribbon. Here you can create: 

• A basic form using the Form tool, the Split Form tool or the Multiple Items tool – these tools 
create a form that appears almost instantly and requires very little work on your part, as all of 
the work is done for you. 

• More intricate forms using the Form Wizard tool – the Form Wizard metaphorically holds your 
hand and asks you a series of questions which ultimately, when answered, result in the form 
being created for you, as specified. 

• A complex, elaborate form using either the Blank Form tool or the Form Design tool – these 
options present you with a blank form canvas and you are required to do all of the work to lay 
out what you want, where you want it, and how it should look. This is the most difficult of the 
options to use as you have to do everything yourself. 

 
Achieving a Balance 

There is no right or wrong way to create forms – choose the method that achieves the results using the 
least amount of time and effort. 
The beauty of the form creation tools in Access is that even after you create a form using any of the 
techniques above, that form can still be modified and customised to suit specifically what you are after. 
So even if the basic form doesn’t quite provide you with what you want or the Form Wizard hasn’t 
quite done all it should, you can still change the form design yourself. 
Many Access users create their forms initially using the Form tool, the Split Form tool or the Form 
Wizard tool, and then fine tune the layout or the design to suit their needs. 
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Try This Yourself: 

O
pe

n 
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 Before starting this exercise 

you MUST open the file 
Creating Forms_1.accdb… 

1 In the Navigation pane, click 
on the Employees table to 
specify the table to use 

2 Click on the Create tab, then 
click on Form in the Forms 
group 

A form layout will instantly 
appear. The layout view of 
the form allows you to make 
adjustments to the form 
template… 

3 Click on the top half of View 
in the Views group to see the 
form in Form View where the 
data is presented 

4 Click on the various Record 
buttons in the Navigation bar 
at the bottom of the screen to 
move through the records 

5 Click on Save in the QAT to 
display the Save As dialog 
box 

6 Type frmEmployees in Form 
Name and click on [OK] to 
save the form 

7 Close the form 

 

 

For Your Reference… 
To create a basic form: 

1. Select the table or query in the Navigation 
pane 

2. Click on the Create tab, and click on Form in 
the Forms group 

Handy to Know… 
• When creating a basic form for a table, linked 

tables will also appear as subdatasheets on 
the form. Access assumes you want to see 
the records from lookup tables in a form. 

CREATING A BASIC FORM 
 

One of the easiest and simplest ways to create a 
form in Access is to use the Form tool which is 
found on the Create tab of the ribbon. All you 
need to do is select the table or query upon 

which to base the form and then click on the tool. 
This is a good way to get an instant form on the 
screen for data entry or editing. 
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Try This Yourself: 

Sa
m

e 
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Continue using the previous 
file with this exercise, or 
open the file Creating 
Forms_2.accdb... 

1 In the Navigation pane, 
click on the Employees 
table 

2 Click on the Create tab, 
then click on More Forms in 
the Forms group and select 
Split Form 
A split form layout will 
instantly appear… 

3 On the Form Layout Tools: 
Design tab, click on View in 
the Views group to see the 
form in Form View 

4 Click on the record buttons 
in the Navigation bar 

5 Click on the record for 
EmpNo 108 (Amanda 
Bennet) to display the 
details in the top form 

6 Click on Save in the QAT to 
display the Save As dialog 
box 

7 Type 
frmEmployeesSplitForm in 
Form Name and click on 
[OK] 

8 Close the form 

 

 

For Your Reference… 
To create a split form: 

1. In the Navigation pane, select the table or 
query 

2. Click on the Create tab, then click on More 
Forms in the Forms group and select Split 
Form 

Handy to Know… 
• Linked tables do not appear in a split form. 

This is because there is already a datasheet 
in the bottom part of the window. 

CREATING A SPLIT FORM 
 

Another quick and basic form that you can create 
in Access is a split form. A split form shows a 
standard form at the top of the screen, where 
only one record appears at a time, and a 

datasheet view at the bottom of the screen. The 
datasheet shows the records in a table format. 
Each time you click on a record in the datasheet, 
the fields for that record appear in the top form. 
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For Your Reference… 
To create a form from a query: 

1. In the Navigation pane, click on the query 
2. Click on the Create tab, then click on Form 

in the Forms group 

Handy to Know… 
• You can create a form from a query using 

Split Form and Multiple Item. 
• Unlike a form based on a table, a form based 

on a query does not show the transactional 
records in the form. 

BINDING A FORM TO A QUERY 
 

The attachment of a table or query to a form is 
known as data binding. One of the strengths of 
Access is that both forms and reports can be 
based on either a full table of data or a subset of 

the table known as a query. When a form is bound 
to a query, the query is run first to extract matching 
fields and records, and then presented in the form 
much the same as a full table would be. 

 
 

 

Try This Yourself: 

Sa
m

e 
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Continue using the previous 
file with this exercise, or 
open the file Creating 
Forms_3.accdb... 

1 In the Navigation pane, click 
on qryEmployees to specify 
the query to use 

2 Click on the Create tab, then 
click on Form in the Forms 
group 

Only the fields specified in 
the query will appear in the 
form layout… 

3 On the Form Layout Tools: 
Design tab, click on View in 
the Views group to see the 
form in Form View where the 
data is presented 

4 Click on Save in the QAT to 
display the Save As dialog 
box 

5 Type frmEmployeeSalary in 
Form Name and click on 
[OK] to save the form 

6 Close the form 

The new form will appear in 
the Navigation pane 
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For Your Reference… 
To create a form using the Form Wizard: 

1. Click on the table or query 
2. Click on the Create tab, then click on Form 

Wizard in the Forms group 
3. Complete the steps of the Wizard 

Handy to Know… 
• When using the Form Wizard, if you have 

made a mistake in any of the Wizard 
screens or would simply like to review your 
work, click on [Back] to move back through 
previous screens. 

USING THE FORM WIZARD 
 

To have more say in what to include in your form 
and how it should look, you can create a form 
using the Form Wizard. The Form Wizard will 
walk you through the steps to create a new form. 

The Form Wizard is made up of several screens, 
each of which requires you to specify what fields to 
include, how it should look, and what the new form 
should be called. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Creating Forms_4.accdb... 

1 In the Navigation pane, 
click on the Employees 
table 

2 Click on the Create tab, 
then click on Form Wizard 
in the Forms group to start 
the wizard 

3 Double-click on EmpNo, 
FirstName, LastName, 
Department and PhoneNo 
to add them to the 
Selected Fields list 

4 Click on [Next] to proceed 
to the next screen, then 
continue working through 
the screens using the 
settings as shown 

5 Once you have specified 
the title in the last screen of 
the wizard, click on [Finish] 
to build the form 

6 Close the form 

 

Screen Settings Click on… 

Layout Columnar [Next] 

Title Employee Phone No  
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For Your Reference… 
To change the views of a form: 

1. Open the form in any view 
2. Click on the bottom half of View and click on 

the desired view 

Handy to Know… 
• Changes to a form’s structure are done in 

either Layout or Design views. Layout view 
provides a view of the form with data in 
place. Design view provides access to more 
of the detailed areas of the form such as the 
header and footer. 

WORKING WITH EXISTING FORMS 
 

Once forms have been created they are ready for 
use. Forms are generally used either to provide 
access to the records and data for editing or just 
simply to search and view data. When you open 

a form from the Navigation pane, it is opened in 
Form View where it is ready for action. There are 
also several other views that you need to be aware 
of when working with forms. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi
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Continue using the 
previous file with this 
exercise, or open the file 
Creating Forms_5.accdb... 

1 In the Navigation pane, 
double-click on 
frmEmployees to open the 
form in Form View 

This is the view where you 
can edit the data… 

2 On the Home tab, click on 
View in the Views group to 
see the form in Layout 
View 

In this view you can make 
changes to the layout of the 
form, including changing 
column widths, colours, 
etc… 

3 Click on View to return to 
Form View 

4 Click on the bottom half of 
View and select Design 
View to see the form 
design 

This is a more sophisticated 
design area of the form… 

5 Click on the Home tab, 
then click on View to switch 
back to Form View 

6 Close the form 
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Try This Yourself: 

Sa
m

e 
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Continue using the previous 
file with this exercise, or 
open the file Creating 
Forms_5.accdb... 

1 In the Navigation pane, 
double-click on 
frmEmployees to open the 
form in Form View 

2 Click and drag over the 
current record number in the 
Navigation bar at the bottom 
of the screen to select it 

3 Type 6 and press  to 
move to EmpNo 106 
(Maureen Grayson) 

4 Click and drag over 
Occupational Safety in the 
Department field and type 
Executive 

5 Click in Comments and type 
Promoted to Executive 
status in March. 

6 Click on Next record to save 
the changes, then click on 
Previous record to return to 
Maureen’s record to see the 
change 

7 Close the form 

 

 

For Your Reference… 
To edit a record through a form: 

1. Open the form, then locate the record to edit 
2. Make the changes as required and move to 

another record to save the changes 

Handy to Know… 
You can move back through the fields on a 
form by pressing + . 
When you edit a record in a form, the edit 
icon will appear in the top left corner of the 
record in the form window. 

EDITING RECORDS IN A FORM 
 

Forms are really intended to make working with 
the data in a table easier by providing better and 
hopefully more intuitive access to the data in the 
records. Forms therefore provide an alternative to 

working in a table and virtually any editing changes 
you can make to the data in the table can also be 
made to the data when it appears in a form. 
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For Your Reference… 
To delete a record using a form: 

1. Open the form in Form View 
2. Locate and select the record 
3. On the Home tab, click on Delete in the 

Records group 
4. Click on [Yes] 

Handy to Know… 
• When deleting records through a form, the 

records are deleted from the table, not the 
form. No matter which form is opened, the 
record will no longer be there because it no 
longer exists in the table. 

DELETING RECORDS THROUGH A FORM 
 

Forms can be used to delete records from a 
table. The first step is to locate the record that 
you want to delete. The deletion process is 
permanent – once a record has been removed it 

cannot be restored. If you are at all unsure about 
removing records, you should make a backup copy 
of the database before you start deleting. 

 
 

 

Try This Yourself: 

 
Sa

m
e 
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 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Forms_6.accdb... 

1 Double-click on 
frmEmployeesSplitForm 
to open the form in Form 
View 

2 In the datasheet, at the 
bottom of the form, locate 
and click to the left of the 
record for George 
Samuelson (EmpNo 109) 

Clicking to the left selects 
the record and activates 
the Delete tool in the 
ribbon… 

3 On the Home tab, click on 
Delete in the Records 
group 

You will be asked to 
confirm the deletion… 

4 Click on [Yes] to delete 
the record 

The record is gone… 

5 Close the form 
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Try This Yourself: 

 
Sa

m
e 

Fi
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 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Forms_7.accdb... 

1 In the Navigation pane, 
click on the Employee 
Phone No form to select 
it 

2 On the Home tab, click on 
Delete in the Records 
group 

A warning about 
permanently deleting a 
form will appear, and you 
will be asked to confirm 
your intentions… 

3 Click on [Yes] to 
permanently delete the 
form 

 

 

For Your Reference… 
To delete a form: 

1. In the Navigation pane, click on the form to 
select it 

2. Click on the Home tab, then click on Delete 
in the Records group 

3. Click on [Yes] 

Handy to Know… 
• It is always a good idea to make a backup 

copy of the database file (e.g. using File 
Explorer) before deleting objects such as 
reports, queries and forms from the file. 

DELETING AN UNWANTED FORM 
 

Forms, like reports, are database objects that 
exist as templates for displaying and working with 
records in a table or query. They can be created 
with relative ease and therefore you will find that 

you create quick, minimal usage forms for 
convenience. Fortunately, you can delete unwanted 
forms even faster than creating them. 
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UNDERSTANDING FORM DESIGN AND LAYOUT 
 

Although you can create your own forms 
completely from scratch, it would be a very 
laborious process. Even seasoned Access 
programmers rely on the form creation tools to 

create a starting form and then adapt and modify 
that to suit their specific requirements. While 
modifying a form is not difficult, there are several 
conceptual aspects you should understand first. 

 
 

 
 

Forms are Templates 
While the word template has 
many different and 
sometimes specific 
connotations in computing, it 
does provide a good way to 
describe what a form really is. 
A form is simply a template 
with objects on it that 
determine what should 
appear on the screen, where 
it should appear, and how it 
should look. 
Everything on a form is an 
object, including the heading, 
logos, data placeholders, 
even the background. 

 
 

Objects on the Form 
Every object on the form, including the form itself (which is an object), has properties that determine 
how the object should look (format), what it should contain (data), and how it should behave (event). 
A special type of object known as a control is used to display data from a table, query or expression 
(formula) in a form. Controls can be bound to a data source (such as a field from a table), or can be 
unbound and appear with static information (such as a heading) or dynamic, changeable information 
(such as the current date). 
So, when you modify a form, you do so by playing around with the objects on the form – resizing 
them, adding more of them, deleting unwanted ones, changing their colours or fonts, etc. 

 
The Three Form Views 

There are three ways to view a form. When you double-click on a form in the Navigation pane you 
will run the form. When the form is running, data from the data source (e.g. table or query) is merged 
into the controls on the form template and displayed on the screen. This is the view that the users of 
your database will employ to see their data. 
There are also two views that allow you to modify the form – Layout View and Design View. With 
both of these views you can move objects around and change properties so that objects look and 
behave the way you want. 
Layout View is more like a layout preview. In Layout View your controls appear with data in them 
just as they would if the form was running. You can modify the controls, move them around, resize 
them, recolour them, and see exactly how they will appear when the form is run because they already 
contain data – from the first record. 
In Design View you can do most of the changes to layout and appearance that you can in Layout 
View, plus you can add controls and finely adjust all of the control settings. In Design View you see 
the names of the controls, not the actual data, and you also see the structure of the form such as its 
header area, body area, and footer area. 
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Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this 
exercise you MUST open 
the file Modifying 
Forms_1.accdb… 

1 In the Navigation pane, 
right-click on 
frmEmployees and 
select Layout View to 
open the form in Layout 
View 

2 Spend a few moments 
studying the options on 
the three Form Layout 
Tools tabs 

3 On the Form Layout 
Tools: Design tab, click 
on the bottom half of View 
in the Views group and 
select Design View to 
see the form in Design 
View 

4 Spend a few moments 
studying the options now 
available on the three 
Form Design Tools tabs 

Many of the options will 
only be available when an 
object or a control on the 
form is selected … 

5 Close the form 

 

 

For Your Reference… 
To switch between form views: 

1. Click on the bottom half of View in the Views 
group 

2. Select either Design View or Layout View 

Handy to Know… 
• It is recommended that you use Layout View 

to make changes to the formatting and layout 
of controls on a form, and Design View 
when making changes to the structure of a 
form such as inserting more controls or 
adding a form footer. 

SWITCHING BETWEEN FORM VIEWS 
 

Access provides two views in which modifications 
to a form can be made: Layout view and Design 
view. Both of these are available from a shortcut 
menu when you right-click on a form in the 

Navigation pane, or they can be switched while 
the form is open using the View tool on the ribbon. 
While both views allow you to make changes to a 
form, there are subtle differences. 
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For Your Reference… 
To select an object on a form: 

Click on the desired object until it appears 
with a selection border 
Hold down and click on subsequent 
objects to select multiple (non-contiguous) 
objects 

Handy to Know… 
• Each object on a form has its own set of 

properties that control how it looks and 
behaves. An object needs to be selected 
before it is possible to access its properties. 

SELECTING FORM OBJECTS 
 

Everything you see on a form, including the form 
itself, is an object. In both Design View and 
Layout View you need to select the object that 
you intend to work with before you can do 

anything with it. Selecting an object is usually as 
simple as clicking on it with the mouse. Once 
selected, an object will appear with a coloured 
border to indicate it is the current object. 

 
 

 

 

 

 

 
 

Try This Yourself: 

Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Forms_1.accdb... 

Open frmEmployees in 
Layout View 
Click on EmpNo to select 
the label control 
An orange border 
indicates that the object is 
selected… 
Click on 101 to select the 
text box control 

Click on EmpNo, then 
hold down and click 

 

on FirstName and 
Executive to select the 
three controls 

Click on the four-headed 
arrow icon at the top left of 
EmpNo to select all of the 
controls in this control 
stack 
A control stack is an object 
that is made up of a group 
of objects... 
Click in the white area of 
the form to select the form 
background 

Click on Employees in the 
heading to select it 

Close the form 

Sa
m

e 
Fi

le
 



LAB 26: QUERYING THE DATABASE / DESIGNING FORMS / PRODUCING REPORTS 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 1
8 

For Your Reference… 
To work with a stack: 

Click on a control to select it 
On the Form Layout Tools: Arrange tab, 
click on Move Down in the Move group to 
move the field in the stack, or 
Press to delete the control 

Handy to Know… 
• On a form, when you delete a control from a 

stack, the other controls below will be moved 
up to ensure the stack stays together. 

• When working with a control stack on a form, 
you can click on Move Up (on the Form 
Layout Tools: Arrange tab) to move 
controls up in the stack. 

WORKING WITH A CONTROL STACK 
 

When a form is created in Access, bound 
controls used for fields from a table or query are 
often placed into a stack. A stack is simply a way 
of grouping controls together so that they can be 

easily moved, resized and consistently spaced. A 
control is part of a stack when a dotted line appears 
around it and a four-headed arrow appears at the 
top left of the lead control. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Modifying 
Forms_1.accdb... 

1 Open frmEmployees in 
Layout View 

2 Click on EmpNo, click on the 
Form Layout Tools: Arrange 
tab, then click on Select 
Layout in the Rows & 
Columns group to select all 
controls in this control stack 

You can also click on the 
four-headed arrow at the top 
left of the stack… 

3 Press  three times to move 
the stack right three positions 

4 Press  three times to move 
the stack left three positions 

5 Click on Salary to select this 
control 

6 On the Form Layout Tools: 
Arrange tab, click on Select 
Row in the Rows & Columns 
group 

7 Click on Move Down in the 
Move group to move the row 
down below Comments 

8 Press  to delete the row 

9 Save and close the form 
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For Your Reference… 
To change control widths: 

1. Point to the appropriate border 
2. Click and drag the border to the left or the 

right to resize the control 

Handy to Know… 
• In a form, when you remove selected 

controls from a control stack, they may 
appear obscured by the controls still in the 
stack. While the removed controls are still 
selected, it is best to move them to another 
position – it may be easier to use the arrow 
keys on the keyboard. 

CHANGING CONTROL WIDTHS 
 

When a form is created using the various 
generation tools, the width of the controls is often 
made the same. One of the first tasks when 
modifying a form is to alter the control widths to 

more accurately reflect the data that will appear in 
the control. Control widths are changed by 
dragging their borders, although a degree of 
complexity is added if the control is part of a stack. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file 

with this exercise, or open the 
file Modifying Forms_2.accdb... 

1 Open frmEmployees in Layout 
View 

2 Click on Kerr to select the 
LastName control 

3 Point to the right border until it 
changes to a double-headed 
arrow, hold down the left mouse 
button, then drag to the left until 
the field (and the stack) is about 
one third of its original size 

4 Release the mouse button to 
complete the resize 

The subform is also resized, but 
we’ll fix that in the next 
exercise… 

5 Right-click on the Comments 
label and select Select Entire 
Row 

6 Right-click on the Comments 
label again, then point to Layout 
and select Remove Layout to 
remove the field from the stack 

7 Click on the blank Comment 
box, then drag the right border 
to the right until the box is about 
twice its size 

8 Save and close the form 
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For Your Reference… 
To move a control: 

1. Click on the control to select it 
2. Point to the control 
3. Hold down the left mouse button and drag 

the control to the desired location 

Handy to Know… 
• To move a control stack on a form, drag the 

four-headed arrow icon to the desired 
location. 

• On a form, selected controls might be easier 
to move using the arrow keys on the 
keyboard. 

MOVING CONTROLS ON A FORM 
 

A control stack manages not only the size of a 
control but also where it is placed relative to the 
other controls. As the name suggests, controls in 
a stack are placed on top of one another. If this 

positioning is not desirable you will need to break 
the stack by removing the controls from it and then 
move those controls to another position on the 
form. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file 

with this exercise, or open the 
file Modifying Forms_3.accdb... 

1 Open frmEmployees in 
Layout View 

2 Click on the four-headed arrow 
icon at the top left of EmpNo to 
select the control stack 

3 Right-click on any of the 
selected controls, then point to 
Layout and select Remove 
Layout to remove all of the 
controls from the stack 

The four-headed arrow icon 
now disappears… 

4 Click in a blank area to 
deselect all controls, click on 
LastName, then hold down  
and click on Kerr to select both 
objects 

5 Point to the selection until the 
pointer becomes a four-headed 
arrow, then click and drag the 
control into position as shown 

6 Repeat steps 4 and 5 to move 
the other controls as shown 

7 Click on the subform to select 
it, then click and drag the right 
border to align it with the right 
edge of the Comments box 

8 Save and close the form 
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Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file 

with this exercise, or open the 
file Modifying Forms_4.accdb... 

1 Open frmEmployees in Design 
View 

2 Hold down  and click on the 
controls as shown to select them 

3 Click on the Form Design 
Tools: Arrange tab, then click 
on Align in the Sizing & 
Ordering group and select Left 
to align the controls along their 
left edges 

4 Click on FirstName, then hold 
down  and click on the other 
controls in the row, as shown 

5 On the Form Design Tools: 
Arrange tab, click on Align in 
the Sizing & Ordering group, 
then select Bottom to align the 
controls horizontally 

6 Using the above steps, align the 
EmpNo column of labels to the 
left, the LastName column of 
labels to the left, and each 
horizontal row to the bottom 

Use the arrow keys to space 
controls horizontally, if needed… 

7 Save and close the form 

 

 

For Your Reference… 
To align controls: 

1. Select two or more controls that need to be 
aligned to one another 

2. On the Form Design Tools: Arrange tab, 
click on Align in the Sizing & Ordering 
group then select the appropriate alignment 
option 

Handy to Know… 
• When aligning controls on a form, if you want 

to align the text within the control use the 
Align Text tools in the Font group on the 
Format tab. 

ALIGNING CONTROLS 
 

Once you start moving controls around a form 
you will realise just how difficult it can be to align 
them again. If you attempt to align controls 
using the mouse and just your eye, you need 

good co-ordination and patience. Fortunately, there 
are a series of Alignment tools on the Arrange tab 
on the ribbon that make aligning controls easy. 
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UNDERSTANDING PROPERTIES 
 

Everything on a form, including the form itself, is 
an object and all objects have specific 
properties that can be modified. Some objects 
have only a handful of properties while others 

may have hundreds. Properties of an object control 
the way it looks, the way it behaves, and what it 
actually does. 

 
 

 

Accessing Object Properties 
In Access there are usually multiple ways to achieve the same end result, especially when it comes 
to properties and the way they are accessed. For example, when you change the font in a control 
the most obvious way to do this is to use the commands on the ribbon. However, when you use 
these commands to change the way an object looks or behaves, you are really changing specific 
properties of that object. Rather than searching for the right command, it is often easier to display 
the Property Sheet pane and adjust the settings using the relevant property. 

 
Understanding the Property Sheet Pane 

The Property Sheet pane displays the properties of the object that is currently selected in the form. 
If no object is selected then the properties of the form itself are displayed. 

The Property Sheet pane consists of five tabs that each display different settings. There are four 
separate tabs (Format, Data, Event, and Other) and a fifth tab which displays the settings from All 
of the tabs: 

• the Format tab displays settings pertaining to the way the control appears (colour, height, 
font, etc.) 

• the Data tab contains settings linking the object to a data source, where relevant (e.g. the 
field in a table) 

• the Event tab contains settings which determine how that object will behave (e.g. when it is 
clicked or changed) 

• the Other tab includes settings that don’t fit into the other 3 tabs. 

The Property Sheet pane contains a wealth of information about the object currently selected. 
 
 
 

Object name 
Object type 

 
 
 
 
 
 
 
 
 
 
 
Object property Property setting 
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For Your Reference… 
To change label captions: 

1. Click on the object to select it 
2. On the Form Layout Tools: Design tab, 

click on Property Sheet in the Tools group, 
then click on the Format tab 

3. Change the text in the Caption property 

Handy to Know… 
• Changing a caption directly on a form is 

probably easier than using the Property 
Sheet pane, if you are renaming several 
captions. The Property Sheet pane might be 
more useful when you want to change 
several properties for a single control. 

CHANGING LABEL CAPTIONS 
 

Fields from a data source such as a table or 
query are represented by a pair of controls in the 
form – one is a label control which shows the 
caption of the field, and the other is usually a text 

box control which shows the data from the field 
when the report is run or in Layout View. The 
caption in the label is often written in a way that 
may be cryptic or confusing to a user. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Modifying 
Forms_5.accdb... 

1 Open frmEmployees in 
Layout View 

2 Click on EmpNo, then on the 
Form Layout Tools: Design 
tab, click on Property Sheet in 
the Tools group to display the 
Property Sheet pane 

3 In the Property Sheet pane, 
click on the Format tab, 
double-click on EmpNo in the 
Caption property to select it, 
then type Employee No and 
press  

4 Click on Close in the top right 
corner of the Property Sheet 
pane to close the pane 

You can also edit a caption 
directly... 

5 Click on FirstName, then 
double-click to select the text 

6 Type First Name, then press 
 

7 Change the other captions as 
shown 

8 Save and close the form 
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For Your Reference… 
To add an unbound control to a form: 

1. Open the form in Design View 
2. On the Form Design Tools: Design tab, 

choose the desired control from the gallery in 
the Controls group 

3. Click in the form to position the new control 

Handy to Know… 
• Bound controls appear differently in Design 

View compared to the other views – in 
Design View they show the field name 
(which is usually the same as the caption) in 
lieu of a field value. 

ADDING AN UNBOUND CONTROL 
 

The fields used for data from a table or query are 
referred to as bound controls – they are bound 
(linked) to a data source. Controls that have no 
links to data are known as unbound controls 

and fall into two categories: dynamic and static. A 
static unbound control is one that doesn’t change, 
while a dynamic unbound control is one that is 
usually based on an expression (formula). 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Modifying 
Forms_6.accdb... 

1 Open frmEmployees in 
Design View 

2 Resize the Started 
control, then move the 
Full Time controls to 
make room for a new 
control, as shown 

3 On the Form Design 
Tools: Design tab, click 
on Text Box in the 
Controls group and click 
in the blank area you 
made in step 2 

4 Point to the small dark 
square above the Text 
label until it changes to a 
four-headed arrow, then 
click and drag it to the 
right to move the label 
closer to the Unbound 
control 

5 Align the row of controls 
so that they are neatly 
arranged 

6 Save and close the form 
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For Your Reference… 
To add a control source: 

1. Click on the unbound control 
2. In the Property Sheet pane, click in the 

Control Source property and type an 
appropriate expression (formula) 

Handy to Know… 
• A control source expression can use both 

round and square brackets, where the 
square brackets are used to indicate the 
name of an existing field. 

ADDING A CONTROL SOURCE 
 

Unbound controls can be used to display static 
text, as in the form of a label control which shows 
the caption for a field, or they can be used to 
display dynamic, changing information. In our 

example, we’ll use an unbound form to show the 
length of service of the employee. This will require 
us to enter a formula, known in Access as an 
expression, into the control source property. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Modifying 
Forms_7.accdb... 

1 Open frmEmployees in 
Design View 

2 Click on the Unbound control 
to select it 

3 On the Form Design Tools: 
Design tab, click on Property 
Sheet in the Tools group to 
display the Property Sheet 
pane 

4 Click on the Data tab, then 
click in Control Source and 
type the formula as shown – 
press  when finished 

5 Click on the Other tab in the 
Property Sheet pane, then 
double-click on the text in the 
Name property to select it 

6 Type YearsOfService and 
press  

7 Close the Property Sheet 
pane 

8 Save and close the form 

 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

ormat((Date()-[Started])/365,”#0.0”) =  
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For Your Reference… 
To format a control: 

1. Click on the control to select it 
2. Change the appropriate properties in the 

Property Sheet pane 

Handy to Know… 
• On a form, the Locked property for a text 

box control locks the control from editing and 
ensures that the user can’t change the value 
that appears. 

FORMATTING A CONTROL 
 

One of the tasks frequently performed when 
modifying a form is to change the formatting 
properties of specific objects. In our case study, a 
new unbound control has been added to the form 

but it has taken on the default formatting rather 
than that of the existing controls. To make the new 
control resemble the existing controls we will need 
to change some of the properties. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Modifying 
Forms_8.accdb... 

1 Open frmEmployees in 
Design View, then click on 
the unbound control 
(YearsOfService) 

2 On the Form Design Tools: 
Design tab, click on Property 
Sheet in the Tools group to 
display the Property Sheet 
pane 

3 Change the properties to: 

Tab Property Setting 
Format Height 0.635cm 
Data   Locked   Yes 

4 Click on the label control to 
select it 

5 Change the properties to: 
Tab Property Setting 
Format Caption Service 
Format Height 

0.635cm 

6 Close the Property Sheet 
pane, then use the alignment 
tools on the Form Design 
Tools: Arrange tab to align 
the controls as shown 

7 Save and close the form 
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For Your Reference… 
To check the tab order of the form: 

Run the form 
Press to move through the fields 

Handy to Know… 
You can press + to move 
backwards through the fields on a form. 
You can use the arrow keys on the keyboard 
to move between fields on a form. 

CHECKING THE CURRENT TAB ORDER 
 

For faster data entry, many users prefer to press 
the  key to move through the fields on a 
running form. When you use the form generation 
tools in Access, the fields are placed into a 

sequential tab order. If you have modified the form 
by moving field controls around there is a good 
chance that the tab order will be out of sequence. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or 
open the file Modifying 
Forms_9.accdb... 

1 Double-click on 
frmEmployees to run the 
form 

2 Press  three times and 
notice how the selected field 
is now Department – if the 
controls were ordered 
sequentially it should be 
Phone No 

3 Press  slowly until you 
eventually get back to 
Employee No and note the 
non-sequential order in 
which Access moves through 
the fields 

4 Close the form 
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Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Modifying 
Forms_9.accdb... 

1 Open frmEmployees in 
Design View 

2 On the Form Design Tools: 
Design tab click on Tab Order 
in the Tools group, to display 
the Tab Order dialog box 

3 Click on [Auto Order] to 
change the order of the 
controls in sequence with the 
layout on the form 

4 Click on [OK] 

5 Save and close the form 

6 Run the form, then press  
to move through the fields to 
ensure that the tab order is 
correct 

7 Close the form 

 

 

For Your Reference… 
To change the tab order of a form: 

1. Open the form in Design View 
2. On the Form Design Tools: Design tab, 

click on Tab Order in the Tools group 
3. Click on [Auto Order] 

Handy to Know… 
• If you want to specify your own order for the 

controls on a form, in the Tab Order dialog 
box, click on the control in the list and drag it 
to the desired location in the list. 

CHANGING THE TAB ORDER 
 

If the tab order of a form is out of sequence, you 
can change it using the Tab Order dialog box. 
This dialog box allows you to specify the order for 
each tab control by dragging them up or down in 

a list. Alternatively, the dialog box has an [Auto 
Order] button which automatically sets the order to 
the sequence in which the controls appear on the 
form. 
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Try This Yourself: 

Sa
m

e 
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Continue using the previous 
file with this exercise, or open 
the file Modifying 
Forms_10.accdb... 

1 Open frmEmployees in 
Layout View 

2 On the Form Layout Tools: 
Design tab, click on Date and 
Time in the Header/Footer 
group to display the Date and 
Time dialog box 

3 Ensure that both Include Date 
and Include Time are ticked 

4 Click on the middle date format 
and the middle time format to 
select them 

5 Click on [OK] to insert the 
current date and time into the 
top right of the form header 
area 

6 Click on the date to select the 
unbound control, then on the 
Form Layout Tools: Format 
tab, click on Bold in the Font 
group 

7 Save and close the form 

 

 

For Your Reference… 
To insert the date and time into the header: 

1. Open the form in Layout View 
2. On the Form Layout Tools: Design tab, 

click on Date and Time in the 
Header/Footer group 

3. Change the settings and click on [OK] 

Handy to Know… 
• The same procedure for adding the date and 

time to a form header can also be used for 
adding a date and time to a report header. 

INSERTING THE DATE INTO THE FORM HEADER 
 

The top part of the form is known as the form 
header. It is usually reserved for information 
such as the name and purpose of the form – for 
instance, our case study form shows the title 

Employees. But you can also use this area to insert 
other controls that display information such as the 
date and the time. 

 
 

 

 
 
 
 
 
 
 
 

 

 



LAB 26: QUERYING THE DATABASE / DESIGNING FORMS / PRODUCING REPORTS 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 3
0 

UNDERSTANDING QUERIES 
 

A select query is like a filter that you place on 
your data so that you see only the information 
that is relevant to you. Select queries can be 
used, for example, to produce a list of customers 

from Tasmania, or all of the items that you've 
purchased in the last six months valued at $300 or 
more. Select queries are so named because they 
select records according to your query design. 

 
 

 

Select queries are created 
using the Create tab of the 
ribbon, and are run and 
modified as a Query object 
in the Navigation pane. 
Select queries are based on 
a Query Design. The upper 
part of the design is known 
as the Field List, while the 
lower portion is known as the 
Query Grid. 

 
Field list 

Query grid 
 
 
 

The records displayed in the 
query are determined by the 
sample data that you enter 
into the Criteria row in the 
Query Grid – this is why the 
process is sometimes 
referred to as query by 
example. 

 
 

Criteria row 
 
 
 
 
 
 

The easiest way to see the 
data is to switch to 
Datasheet view. In 
Datasheet view the data that 
matches the query criteria is 
displayed in a special 
dynaset table. A dynaset is 
a subset of the full table of 
data – however, it is still a 
live set of data and any 
changes made to data here 
will be reflected back in the 
full table later on. 
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For Your Reference… 
To create a query design: 

1. Click on the Create tab 
2. Click on Query Design in the Queries group 
3. Add the table and select the fields 
4. Save the query 

Handy to Know… 
• The Show Table dialog box, displayed when 

creating a new query design, lists all of the 
tables and queries in the current database 
file. 

CREATING A QUERY DESIGN 
 

Queries are created from the Create tab on the 
ribbon. Like table structures, there is a design 
view where the layout, criteria, and the like, 
required for the query are specified, and a run 

view where the data is brought into the design 
layout structure from the relevant table. The first 
step in creating a query, therefore, is to create a 
query design structure. 

 
 

 

 

Double-click on the entries here to add them to the 
table below 

 

 

 
 
 
 
 
 
 

Try This Yourself: 

O
pe

n 
Fi

le
 

Before starting this 
exercise you MUST open 
the file Creating 
Queries_1.accdb… 

1 Click on the Create tab, 
then click on Query 
Design in the Queries 
group to display a new 
query design and the 
Show Table dialog box 

2 Click on [Add] to add the 
Employees table fields to 
the design, then click on 
[Close] to close the dialog 
box 

3 In the field listing 
double-click on EmpNo, 
LastName, FirstName 
and Department to add 
these fields to the grid in 
this order 

4 Click on Save in the QAT 
to display the Save As 
dialog box 

5 Type qryEmployees in 
Query Name, then click 
on [OK] 
The name of the query will 
now appear in the 
Navigation pane under the 
Queries header… 

6 Close the query 
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For Your Reference… 
To see different aspects of a query: 

1. Double-click on the query to see it in 
Datasheet view 

2. On the Home tab, click on the top half of 
View in the Views group to toggle between 
Design and Datasheet views 

Handy to Know… 
• Until you seriously get into programming, you 

won't use the SQL View option for queries all 
that often. SQL is pronounced "sequel" or 
simply S.Q.L. 

WORKING WITH A QUERY 
 

Queries offer you the ability to see snapshots of 
your data – a particular view or representation of 
your data at a point in time. There are three main 
views within a query: the design view where you 

specify what data you wish to see in the snapshot; 
the datasheet view where the data based on the 
design is displayed; and SQL view which shows 
the programming behind the query. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Queries_2.accdb... 

1 Double-click on 
qryEmployees to see 
the query in Datasheet 
view, displaying the data 

2 On the Home tab, click 
on the top half of View 
in the Views group to 
toggle between Design 
and Datasheet views 

3 Click on the bottom half 
of View to display a 
menu of options 

4 Select SQL View to see 
the SQL code required 
behind the scenes to 
create the query 

5 Close the query 
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For Your Reference… 
To insert more fields into a Design grid: 

• Double-click on the field name in the field 
listing, or 

• Click in the grid, then click on Insert 
Columns in the Query Setup group 

Handy to Know… 
• You can delete a field from a query grid by 

clicking on it and then clicking on Delete 
Columns in the Query Setup group on the 
Home tab. 

CHANGING A QUERY DESIGN 
 

Most query designs are not as critical as table 
designs and can therefore be changed randomly 
and when the need arises. Select queries, 
where you are trying to extract matching data, 

are often run using a trial and error approach where 
the query design is experimented with and modified 
until the perfect solution is found. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Queries_3.accdb... 

1 In the Navigation pane, 
right-click on 
qryEmployees to display a 
menu of options, then select 
Design View to see the 
query in Design view 

2 Scroll down the list of fields 
in the Employee field listing 
and double-click on 
WeeklyHours and then 
Salary to place both fields 
at the end of the grid 

3 Click on WeeklyHours in 
the grid then, on the Query 
Tools: Design tab, click on 
Insert Columns in the 
Query Setup group 

A new, blank column will 
appear… 

4 Click on the drop arrow in 
the new column and select 
Started 

5 Click on the Home tab, then 
click on the top half of View 
in the Views group to run 
the query and see the data 
presented in the modified 
design 

6 Click on Save in the QAT, 
then close the query 
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For Your Reference… 
To select records in a query: 

1. Click in the Criteria cell for a field and type 
the desired search criteria 

2. On the Query Tools:Design tab, click on 
View in the Views group to run the query 

Handy to Know… 
• When creating queries, if you add more 

criteria across fields, you are creating what is 
known as an AND query – you want records 
that have this AND this AND this... 

• When constructing queries, use > for greater 
than and < for less than situations. 

APPLYING RECORD CRITERIA 
 

The real power of a query lies in its ability to 
display a filtered list of records in a dynaset. To 
filter the records and see only the ones that you 
want, you will need to enter search criteria in the 

criteria row in the query grid. You simply type an 
example of the data that you want to see in the 
criteria cell and run the query to display all records 
from the original table that match the criteria. 

 
 

 

 
 

 
 

 
 
 
 
 

 

Try This Yourself: 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Queries_4.accdb... 

 

Right-click on 
qryEmployees to display a 
menu of options and select 
Design View 
Click in the Criteria cell for 
Department and type 
Administration 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to see only those 
records with 
Administration in the 
Department field 

Repeat step 3 to switch 
back to Design view 

Type 40 in the Criteria cell 
for WeeklyHours, then click 
on View to display only 
those people who work 40 
hours in the 
Administration department 

Switch to Design view and 
type >=80000 in the 
Criteria cell for Salary, then 
click on View to see all 
Administration people who 
work 40 hours and earn 
$80,000 or more 

Save and close the query 

Sa
m

e 
Fi

le
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For Your Reference… 
To clear selection criteria: 

Point to the left of the row and click once to 
select it 
Press to delete the criteria in the row 

Handy to Know… 
When working with a query design, you can 
delete the contents of a single cell in the 
Criteria row by double-clicking on the value 
in the cell and pressing . 

CLEARING SELECTION CRITERIA 
 

You do need to exercise a little care when 
running queries. If you leave residual criteria from 
an earlier query in the query grid (which is easy 
to do if you have more fields than can be seen on 

the screen), you may end up with incorrect results. 
It is a good idea therefore to clear the selection 
criteria after you have performed a query and found 
the data that you want. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Queries_5.accdb... 

1 In the Navigation pane, 
right-click on 
qryEmployees to display a 
menu of options and select 
Design View 

2 Point to the left of the first 
criteria cell until the mouse 
pointer changes to a black 
horizontal arrow 

3 Click once to select the 
entire criteria row 

4 Press  to delete all of 
the criteria in the row 

5 Save and close the query 
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For Your Reference… 
To save a query: 

1. Create the query 
2. On the File tab, click on Save As, then click 

on Save Object As and click on [Save As] 
3. Type a name and click on [OK] 

Handy to Know… 
• It is important to give your queries 

meaningful names so that you remember 
what they are for. Using a prefix, such as 
qry, will tell you at a glance that you are 
looking at a list of queries and make the 
queries easier to distinguish from tables, 
forms and reports. 

SAVING A QUERY 
 

There are two main types of select queries: those 
that you create as a one-off search of the data; 
and those that you create for repeated and 
on-going use. If you are going to use a query on 

a regular basis it should be saved. You can then 
also use it as a template to create other queries 
with variations perhaps to the criteria or the field 
grid. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Queries_6.accdb... 

1 Right-click on qryEmployees 
to display a menu of options 
and select Design View 

2 Type Administration in the 
Criteria cell for Department 

3 On the Query Tools: Design 
tab, click on View in the Views 
group to see the results – 
there should be 26 records 

4 Click on the File tab, then click 
on Save As to display the 
Save As area 

5 Click on Save Object As in 
File Types, then click on 
[Save As] to display the Save 
As dialog box 

6 Type qryEmployeesAdmin 
and click on [OK] 
The new query appears in the 
Navigation bar… 

7 Switch to Design view then 
repeat steps 2 to 6 to create 
another query that only 
displays employees from the 
Executive department – save 
this query as 
qryEmployeesExec 

8 Close the query 
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For Your Reference… 
To run a query from the Navigation pane: 

• In the Navigation pane, double-click on the 
name of the query from the Query object list 

Handy to Know… 
• Queries do not contain data. Each time a 

query is opened in Datasheet view, Access 
retrieves the latest data from the table upon 
which the query is based and uses the query 
design to display the relevant records and 
information. 

RUNNING QUERIES FROM THE NAVIGATION PANE 
 

Queries store the layout, fields, criteria and other 
information required to produce the list of data 
that you want. Given that they can be time 
consuming to create, especially in the case of 

complex queries, it makes sense to save them and 
then run them as often as you require. Queries can 
be run directly from the object listing in the 
Navigation pane, as often as you like. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the file 
Creating 
Queries_7.accdb... 

1 In the Navigation pane 
under Queries, 
double-click on 
qryEmployees, then 
double-click on 
qryEmployeesAdmin, 
then double-click on 
qryEmployeesExec 

Notice how the names of 
the three queries appear 
in three separate tabs at 
the top of the window. 
The last query opened is 
the one that is currently 
seen and is known as the 
“active” query… 

2 Click on the tab for 
qryEmployeesAdmin to 
see the employees in the 
Administration 
department 

3 Click on the tab for 
qryEmployees to see all 
of the employees 

4 Close each query 
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For Your Reference… 
To delete a query from a database file: 

1. Click on the name of the query in the 
Navigation pane 

2. On the Home tab, click on Delete in the 
Records group 

Handy to Know… 
You can delete a query by clicking on it in the 
Navigation pane and pressing . 

DELETING A QUERY 
 

Queries often work with data that is stored in 
tables or that results from other queries. They 
can be used to create data by performing 
calculations and can be used as a source of data 

for other queries, forms and reports. Therefore, you 
should be especially careful when deleting queries 
– make sure that the query is not used by any other 
objects in the database first. 

 
 

 

Try This Yourself: 

 
Sa

m
e 

Fi
le

 Continue using the 
previous file with this 
exercise, or open the 
file Creating 
Queries_7.accdb... 

1 Click on 
qryEmployeesExec in 
the Navigation pane 
to select it 

2 On the Home tab, click 
on Delete in the 
Records group 

A warning message 
will appear, seeking 
your confirmation to 
delete the query… 

3 Click on [Yes] to 
confirm the deletion 

The query no longer 
appears listed under 
Queries in the 
Navigation pane 
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Select queries are by far the most common type 
of query that you will create and use. In this 
assignment you will have the opportunity to put 
your understanding of queries to use by creating 

a wide range of different queries, including those 
that show records that match specific criteria, and 
those that fit within specific ranges of dates. 

 
 

 

Sub Heading 
Use the qryEmployees query to run the various queries as shown. Note that you will have to clear the 
criteria from time to time. Also, we won’t need these queries so there is no need to save them. 
Save the final query design as qryEmployeesNew then close it. 
The datasheet that shows the results is exactly like a table and you can therefore use the Print 
commands on the File tab to print the result once the datasheet is displayed. 
Access automatically places quotation marks around criteria based on text. The quotation marks are 
programming symbols that tell the computer to treat the data as character strings rather than numbers. 
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UNDERSTANDING REPORTING IN ACCESS 
 

Reports provide you with a means of more 
formally presenting, and even analysing, data 
from your tables and queries. Reports have 
traditionally been produced as printed documents 

but they can also be viewed on the screen or 
published to the web. Before creating a report, it is 
advisable to understand how they work and what 
they can actually do for you. 

 
 

 

Creating Reports 
All database systems, including Access, provide you with a report generator facility to design your 
reports. Reports themselves do not contain data, but are created as structural templates into which 
the data is placed when the report is run. The template basically defines what to display (e.g. which 
fields to use), where to display it (e.g. where the fields should appear on the page), and how it should 
look (e.g. font size, colour, etc). 
When a report is first created it is based on either an existing table or an existing query. You base the 
report on a table if you wish to report on all of the data, or a query if you wish to report on just a 
subset of the data. 

 
The Many Ways of Creating a Report 

In Access you can create simple reports or very complex and intricate reports. So, as you’d expect, 
Access offers several ways for you to create reports. In Access, reports are created from the tools on 
the Create tab on the ribbon. Here you can create: 

• A basic, no frills report using the Report tool – these reports appear almost instantly and 
require very little work on your part. All of the work is done for you. 

• More intricate reports using the Report Wizard tool – the Report Wizard metaphorically holds 
your hand and asks you a series of questions which ultimately, when answered, result in a 
report. 

• A complex, elaborate report using either the Blank Report tool or the Report Design tool – 
these options present you with a blank report canvas and you are required to do all of the work 
to lay out what you want, where you want it, and how it should look. This is the most difficult of 
the options to use as you have to do everything yourself. 

 
Achieving a Balance 

There is no right or wrong way to create reports – choose the method that achieves the results using 
the least amount of time and effort. 
The beauty of the reporting tools in Access is that even after you have created a report using any of 
the techniques, the report can still be edited, modified and customised to suit specifically what you are 
after. So even if the basic report doesn’t quite provide you with what you want or the Report Wizard 
hasn’t quite done all it should, you can still change the report design yourself. 
Many Access users create their reports using the Report tool or the Report Wizard tool, and then 
fine-tune the layout or the design to suit their needs. 
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For Your Reference… 
To create a basic report: 

1. Click on the table or query in the Navigation 
pane 

2. Click on the Create tab, then click on Report 
in the Reports group 

Handy to Know… 
• When creating reports, Layout view allows 

you to make changes to the layout of a 
report, such as column widths, row heights, 
field placement etc. Report view is the 
polished view of the report. 

CREATING A BASIC REPORT 
 

The easiest and simplest way to create a basic 
report in Access is to use the Report tool which 
is located on the Create tab on the ribbon. All 
you need to do here is to select the table or the 

query in the Navigation pane as the basis for the 
report and then run the command. 

 
 

 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file 
Reports_1.accdb… 

1 In the Navigation pane, click 
on the Employees table to 
select it 
This indicates the table to 
base the report on… 

2 Click on the Create tab, then 
click on Report in the 
Reports group 
A report layout will instantly 
appear. The Layout View of 
the report allows you to make 
adjustments to the report 
template… 

3 On the Report Layout Tools: 
Design tab, click on View in 
the Views group to see the 
report in Report View where 
the data is presented 
Data is presented in Layout 
View as well, but Report View 
is the finished view of the 
report… 

4 Click on Save in the QAT to 
display the Save As dialog 
box 

5 Type rptEmployees in 
Report Name, then click on 
[OK] to save the design and 
layout 

6 Close the report 
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For Your Reference… 
To change the report view: 

1. Open the report in any view 
2. On the Home tab, click on the bottom half of 

View in the Views group and select the 
desired view 

Handy to Know… 
• Changes to report structure are made in 

either Layout or Design view. Layout view 
provides a view of the report with data in 
place. Design view provides access to more 
of the detailed areas of the report such as 
the header and footer. 

WORKING WITH EXISTING REPORTS 
 

Reports do not contain data – they are simply 
templates with field placeholders which 
determine where data will be placed. As a 
consequence there are several different views of 

a report – you can see its structure in both the 
Design and Layout views, and you can see data in 
Report, Print Preview and Layout views. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Reports_2.accdb... 

1 Double-click on the report 
rptEmployees to open it 

Report view shows you 
the report with data. No 
changes can be made to 
either the data or the 
report layout here… 

2 On the Home tab, click on 
View in the Views group 
to see the report in Layout 
view where changes can 
be made 

The View tool toggles 
between Layout and 
Report views… 

3 Click on the bottom half of 
View and select Design 
View 
Design view is the ultimate 
design and layout view 
where you can edit the 
fields, placements and 
even formats, and also 
make changes to report 
headers and footers… 

4 Close the report 
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For Your Reference… 
To preview and print a report: 

1. Right-click on the report in the Navigation 
pane and select Print Preview to see the 
report in preview mode 

2. On the Print Preview tab, click on Print in 
the Print group to print the report 

Handy to Know… 
• Basic reports seldom print well without a bit 

of editing. Typically there may be too many 
columns or rows to fit neatly on a page. 

PREVIEWING AND PRINTING A REPORT 
 

Reports are commonly designed for and printed 
on paper using a printer. While you can print a 
report without directly running it, it is a good idea 
to use Print Preview to see how it will look 

before it is sent to the printer. Often you will find 
that the report is too wide or needs to be changed 
in some other way prior to a formal print run. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file Reports_2.accdb... 

1 Right-click on rptEmployees 
and select Print Preview to 
see the report in preview mode 

2 Click on Next Page and 
Previous Page at the bottom 
of the window several times to 
view the pages 

The report is too wide to fit on 
one piece of paper… 

3 On the Print Preview tab, click 
on Landscape in the Page 
Layout group to turn the report 
sideways 

We still haven’t got all columns 
on one page, but let’s print just 
the first page to see how it 
looks… 

4 Click on Print in the Print 
group to display the Print 
dialog box 

5 Click on Pages in Print Range 
and type 1 in both From and 
To 

6 Click on [OK] to print the first 
page of the report 

7 Close the report 
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For Your Reference… 
To adjust column width in a report: 

1. Open the report in Layout view 
2. Click in the column to change 
3. Point to the right border of the orange 

square, hold down the left mouse button and 
drag left to narrow the column 

Handy to Know… 
• The grey dotted lines that appear in Layout 

view of a report indicate whether the page 
will break when printed. These dotted lines 
are based on the current printer settings on 
your computer and are very useful when 
trying to resize a page of the report. 

CHANGING THE REPORT LAYOUT 
 

The Layout view provided for reports in Access 
allows you to make adjustments to the layout of 
the report. These adjustments may be required 
for aesthetic purposes, to make the report more 

visually appealing, or for practical purposes such 
as trying to squeeze the report onto one page. In 
Layout view you can adjust column widths and 
instantly see whether they will work or not. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file Reports_3.accdb... 

1 Right-click on rptEmployees 
and select Layout View 

2 Point to the right border of the 
orange square surrounding 
Emp No 101 

The pointer should change to a 
double-headed arrow… 

3 Hold down the left mouse 
button and drag the border left 
to make the column narrower 

4 Click in the FirstName column, 
then repeat steps 2 and 3 to 
make this column narrower 

5 On the Report Layout Tools: 
Design tab, click on the bottom 
half of View in the Views 
group, select Print Preview, 
then click on One Page in the 
Zoom group to see if the 
Comments fit on the page 

6 Click on Close Print Preview 
in the Close Preview group, 
then repeat steps 2 and 3 with 
the other columns, until the 
Comments column is on the 
page 

7 Save and close the report 

 
 

 

 

 



LAB 26: QUERYING THE DATABASE / DESIGNING FORMS / PRODUCING REPORTS 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 4
5 

 

 

For Your Reference… 
To create a report using the Report Wizard: 

1. Click on the table or query 
2. Click on the Create tab, then click on Report 

Wizard in the Reports group 
3. Complete the steps of the Wizard 

Handy to Know… 
• When creating a report using the Report 

Wizard, if you have made a mistake in any of 
the screens or would simply like to review 
your work, click on [Back] to move back 
through previous screens. 

USING THE REPORT WIZARD 
 

The Report Wizard will guide you through the 
process of creating more formal reports from the 
data in your data table. The Report Wizard 
consists of a number of screens that prompt you 

for the information required to generate a report. 
Some of the screens may seem cryptic to begin 
with, but you will soon learn what is required and 
be able to generate reports quickly and efficiently. 
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Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file Reports_4.accdb... 

1 In the Navigation pane, click 
on the Employees table to 
specify the table to report on 

2 Click on the Create tab, then 
click on Report Wizard in the 
Reports group to start the 
Report Wizard 

3 Double-click on EmpNo, 
FirstName, LastName, 
Department and PhoneNo in 
Available Fields to add them 
to the Selected Fields list 

4 Click on [Next] to proceed to 
the next screen. Continue 
working through the screens 
using the settings as shown 

5 Once you have specified the 
title in the last screen of the 
wizard, click on Preview the 
report, then click on [Finish] 
to build the report 

Spend a moment previewing 
the report… 

6 Close the report 

The new report is now listed in 
the Navigation pane 

 

Screen Settings Click on… 

Grouping No change [Next] 

Sort Order 1. LastName, Ascending [Next] 

Layout Tabular & Portrait [Next] 

Title Employee Phone Listing  
 



LAB 26: QUERYING THE DATABASE / DESIGNING FORMS / PRODUCING REPORTS 
 

MUSTANSIRIYAH UNIVERSITY \ COLLEGE OF DENTISTRY \ FIRST STAGE MUSTAFA H. ALI  

Pa
ge

 4
6 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Reports_5.accdb... 

1 In the Navigation pane, 
click on the Employees 
table 

2 Click on the Create tab, 
then click on Report 
Wizard in the Reports 
group to start the Wizard 

3 Double-click on 
Department, EmpNo, 
LastName, FirstName, 
Started and Salary, then 
click on [Next] 
In this screen you are 
required to specify how to 
group the records… 

4 Double-click on 
Department as the 
grouping level 

5 Click on [Next] and 
complete the remaining 
wizard screens as shown 

6 Click on [Finish] to build 
the report 

7 Close the report 

 

 

For Your Reference… 
To create a grouped report: 

1. Click on the Create tab, click on Report 
Wizard and create a report, selecting the 
field to be grouped on as the first field 

2. Select this field on the Grouping screen 
3. Complete the wizard and save the report 

Handy to Know… 
• When creating a grouped report, you may 

find that you need to make minor 
adjustments to column widths in Layout 
View to be able to see all of the grouping 
column. 

CREATING A GROUPED REPORT 
 

By creating a grouped report you can present 
data so that it is grouped according to one or 
more fields. For example, if you create a grouped 
report listing all employees by department, the 

departments will be listed in alphabetical order and 
the employees will be listed in alphabetical order 
within each department. 

 
 

 

 
 
 
 
 

 

 

Screen Settings Click on… 

Sort Order 1. LastName, Ascending [Next] 

Layout Stepped & Portrait [Next] 

Title Employee Salary Listing  
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Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file Reports_6.accdb... 

1 In the Navigation pane, click 
on the Employees table, click 
on the Create tab and click on 
Report Wizard in the Reports 
group 

2 Double-click on Department 
and Salary, then click on 
[Next] 

3 Double-click on Department 
as the Grouping level, then 
click on [Next] 

4 Click on [Summary Options] 
to display the Summary 
Options dialog box 

5 Click in the tick boxes for Sum, 
Avg, Min and Max, then click 
on Summary Only in Show 

6 Click on [OK] to return to the 
Wizard, then click on [Next] 
and complete the settings as 
shown 

7 Click on [Finish] to build the 
report 

We will fix the hash signs in 
the next exercise… 

8 Close the report 

 

 

For Your Reference… 
To create a statistical summary report: 

1. Create a grouped report using the wizard 
2. Click on [Summary Options] on the sorting 

screen 
3. Click on the statistics required then click on 

[OK] and finish creating the report 

Handy to Know… 
• When a report displays hash signs (####) in 

lieu of numbers, it is because the column 
size in the report isn’t large enough to display 
the values in the fields. 

CREATING A STATISTICAL REPORT 
 

One great feature of reports is the ability to 
summarise the data in the database. For 
example, reports allow you to calculate the total 
(sum), minimum, maximum, average, and 

number of records (count) for numerical fields in a 
database. You can also count non-numerical fields. 
These statistical reports assist with analysis of 
the data in the database. 

 
 

 

 
 
 
 
 

 

 

Screen Settings Click on… 

Layout Stepped & Portrait [Next] 

Title Salary Analysis Report  
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For Your Reference… 
To modify the layout of a grouped report: 

1. Open the report in either Report Layout or 
Report Design view 

2. Make the changes to the layout as required 

Handy to Know… 
• You can adjust field widths either through 

Report Design view or in Report Layout 
view. However, =Sum (that sums the footer) 
is easier to access in Report Design view. 

WORKING WITH GROUPED REPORTS 
 

If a column is not wide enough to display values, 
Access will substitute the values with cryptic 
signs like the hash (#) symbol. This can happen 
when using the statistical functions (sum, avg, 

etc.) on the values that involve many numbers, 
such as currency. To correct this problem you will 
need to access either Layout View or Design 
View and modify the column widths. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Reports_7.accdb... 

1 In the Navigation pane, 
double-click on Salary 
Analysis Report to run it 

Here you can see the hash 
signs replacing numbers… 

2 Switch to Design View 

3 In Department Footer, 
click on =Sum([Sal, hold 
down  and click on 
=Avg([Sal, =Min([Sal, 
=Max([Sal and =Sum([Sal 
(in Report Footer) 
You should have selected 
five fields… 

4 Point to the left border of 
one of the selected fields, 
click and drag to the left 
until the fields are about 3 
times as long 

5 Click on the Home tab, 
click on the bottom half of 
View in the Views group, 
then select Report View to 
run the report – this time 
the values are displayed 

6 Save and close the report 
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